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TELECOMponent Basics
The TELECOMponent can be accessed by running it as a stand-alone program (V3TELMCP.EXE) or 
from within the COMponent Workspace.    If run from within the COMponent Workspace the user mode 
(Novice vs. Advanced) effects the amount of information in windows that the TELECOMponent will allow 
you to create.

There are a few major differences when the TELECOMponent is run in Novice vs. Advanced mode.    In 
Novice mode the Mailbox/Log view is not displayed automatically, you must access the Mailbox/Log view 
from the Telephony menu or the button bar.    You are also only allowed to have one TELECOMponent 
Window up at any one time.    This means only one modem will be able to answer incoming VoiceMail call 
or place outbound Telephony calls.    In Advanced mode all features are available.

A TELECOMponent Window file (.TEL) is the document that provides access to your modem and its 
settings.    There is a one to one relationship between TELECOMponent Windows and installed modems.  
In order to receive VoiceMail calls or dial Telephony calls, you must create or open a TELECOMponent 
Window for each modem you have installed.    You can create a new TELECOMponent Window by 
selecting “New..” from the “File” menu.    If you have more than one modem installed, you will be prompted
to select which modem you want to associate with the window.    Once the modem has been associated 
with the window, the line will be initialized and made operational.



TELECOMponent Environment

The TELECOMponent application is another module in the suite of COMponent modules.

It can be run as a stand-alone application, but it also is automatically integrated into the COMponent 
Workspace.    All of the functionality provided by the TELECOMponent is available no matter how it is run 
or where it is accessed from.

The TELECOMponent, like other COMponent modules allows you to create any number of windows 
within its workspace.    This capability is called the “Multiple Document Interface” and is a standard user-
interface model which is used in many other Windows applications and should be famailiar to the 
Windows user with only a small amount of experience.

The “Multiple Document Interface” (MDI) is a powerful user interface model that allows you to open more 
than one document, in this case, TELECOMponent window simultaneously.    This allows you to run 
multiple modems on different lines simultaneously.

There is one type of document that the TELECOMponent can create or edit:

TELECOMponent Window (.TEL)
A TELECOMponent window can be created for each voice capable modem you have 
installed in your system.    All of the many VoiceMail related settings for each modem are 
stored in the TEL file.    This capability allows you to store different settings in different TEL 
files and open them at a later time without having to recreate special settings.    The 
TELECOMponent window consists of three different views in Advanced Mode.    In Novice 
Mode the Mailbox/Log View is not available:

Mailbox/Log View
Displays the available mailboxes and log entries.    This view contains a 
hierarchical list box on the left and detailed log list on the right.    For each folder 
or subfolder that is selected on the left pane, the corresponding log entries are 
displayed on the right.    You can use SHIFT+LEFTCLICK and 
CTRL+LEFTCLICK to select more than one folder or sub-folder at a time.    This 
allows you to view log entries for more than one mailbox or of more than one type
at a time. And perform operations such as View and Delete on multiple log 
entries.

Status View
Allows you to easily see details of the current Telephony or VoiceMail call.    Also 
allows you to close down the COM port associated with the document by simply 
selecting the On/Off button.    Users who use other COM programs such as RAS 
or internet applications will find the function invaluable.    This view also allows 
you to easily leave voice memos and play and view receive fax and voice 
messages.    If you have multiple mailboxes configured you can switch between 
mailboxes to see whether messages have been received or to change the 
mailbox greeting.

Keypad View
Displays the speed dial list and Kepad use to dial outbound telephony calls.

The TELECOMponent is automatically configured to “remember” the position and information contained in
the documents you have open when you close it down.    Moreover, when you restart the application, the 
previously opened documents will be automatically re-opened for you and any TELECOMponent 
Windows you had open will attempt to open a connection to your modem.    You can turn this capability off
in the Workspace dialog from the Options menu.



As with the other COMponent modules, the TELECOMponent contains a Tools menu and an Options 
menu that are always available.    The Tools menu, among other things, provides access to showing and 
hiding toolbars.    The Options menu can be used to alter settings related to the TELECOMponent itself, 
such as the Workspace settings described above



Getting Started With VoiceMail
The TELECOMponents VoiceMail Module can be run in two distinct modes.    It is important to note that 
the mode in which the VoiceMail system is running is completely independant of the user mode in which 
COMponents is running (Novice vs. Advanced).    You can set the appropriate mode in the Voice System 
Setup - Prompts Tab.

Simple Answering Machine Mode
This mode is enabled by default when COMponents is first installed.    This mode 
makes the TELECOMponent behave as a simple answering machine.    When an 
incoming call arrives a simple greeting message (a default one is supplied, but 
you can record your own) is played to the caller and then the caller is given the 
opportunity to leave a message.    The message is stored in the System Mailbox 
which is also created for you by default and which has the mailbox number of 0.   

Simple mode only refers to how the VoiceMail system operates with regard to 
incoming voice calls.    All other features such as recording greetings, leaving 
memos, archiving messages and listening to messages are the same whether 
running in Simple or in Advanced Mode.

VoiceMail System Mode
This mode provides the caller with all the features that TELECOMponents 
supports.    For more specific information on the voice tree architecture please 
see:    Voice Tree Specification.    In this mode the user will be able to send and 
receive faxes to specific mailboxes, retrieve Fax-on-Demand documents, leave 
messages, retrieve messages remotely, and make use of many other options.

Since COMponents does not ship with default message files for all of the 
required prompts that exist in advanced mode, you must record all prompts 
before advanced mode will function.    To learn more about recording prompts for 
the Voice Tree, please see:    Voice System Setup - Prompts Tab.

Assuming that you have recorded the appropriate prompts for the Voice Tree mode that you would like to 
run in, you should be ready to receive VoiceMail calls. 

Note:    In order to be able to send or receive faxes from VoiceMail, you must also have a FAXCOMponent
window up and running on the same line that you are running the TELECOMponent on.    If you are 
running the Queue Server to answer your calls, a Fax line is opened for you automatically.

There is currently no way to “test” the functionality of the Voice Tree locally (without calling in).    This 
feature will be included in the next major release.    For now, we suggest that after you have recorded all 
of the required prompts, that you call in and try various things in the VoiceMail system to get a feel of how 
it operates.    Specific documentation on the VoiceMail Tree structure is available in the following topic: 
Voice Tree Specification.

We encourage you to explore all of the dialogs and interface to get a complete idea of what 
TELECOMponents is capable of.



File Menu

New ...
Open ...
Close
Save
Save As ...
Save All
Print Setup...
Exit



New

Creates a new TELECOMponent window and attaches it to a communications line.

In advanced mode you may open as many windows as you would like.    Keep in mind that each 
TELECOMponent Window, however, must be connected to a unique line.



Open

Opens an existing TELECOMponent document.

You would use this feature to open documents that you had previously saved, perhaps containing 
particular settings that you would like to use again.



Close

Closes the active document window.

Although several documents may be open at once, this command closes only the active document (you 
make a document active by clicking on its title bar.)



Save

Saves the active document to the directory and filename associated with it when the file was opened.

Although several documents may be open at once, this command closes only the active document (you 
make a document active by clicking on its title bar.)



Save As

Saves the active document to a different directory and/or filename than it was associated with when it was
opened.

Although several documents may be open at once, this command closes only the active document (you 
make a document active by clicking on its title bar.)



Save All

Saves all open documents at once.



Printer Setup

Opens the Print Setup dialog box which allows you to change the printer you wish to print to or the print 
characteristics of your current printer before you print a document.

Print characteristics are things like print quality, paper type, media size, etc.



Exit

Exits from the TELECOMponents program.



Help Menu

Index
Using Help

About TELECOMponent



About TELECOMponent

Display system, version and distribution information about the TELECOMponent.



Options Menu
Location ...
Workspace ...
Language ...
Line/Modem Setup...
o.tel.o Multi-Fax...



Location
This dialog allows you to change settings specific to your current physical location.    These 

settings are used when sending faxes or calling other modems to build the proper dialiable phone number
and for text substitution on the cover pages and headers.

See Also:    Location Tab



Workspace
You may customize the look and feel of the applications windows from this dialog.    In addition to 

changing the background color and displaying bitmaps on the background you may also choose the user-
mode, Novice or Advanced.

See Also:    Workspace Tab



Language
Use this dialog to switch the language the user-interface is currently using.    If you have more 

than one language intstalled, you will be presented with all available languages in a list.    When you 
change the language, the user-interface will instantly change to the new language.    No rebooting or 
restarting the software is necessary.

See Also:    Language



Line/Modem Setup
If you wish to add, remove, or modify lines/modems from COMponents this is the correct option to

select.    This dialog allows you to auto-detect and Add newly installed modems as well as edit the 
configuration of exsitsing modems.

See Also:    Line/Modem Setup Dialog



Workspace Settings - Colors Tab
Use this dialog to specify the colors to use in the TELECOMponent status display.    Select the 
item you wish to change the color for in the combo box and then use the color button to 
select the desired color.

Changing colors in this dialog will only modify the color for the active COMponent 
application.    For example, if you would like the colors changed in both the COMponent 
Workspace and in the Queue Server, you must invoke the Workspace Dialog from each 
application independantly.



o.tel.o Multi-Fax
o.tel.o Multi-Fax is the service for sending high volume faxes from this client through o.tel.o 
Muli-Fax service. You can design your faxes in your favorite Windows application, and print it 
through the fax component printer driver. You can as well attach TIFF, and ASCII files.

See Also:    o.tel.o Multi-Fax Service Setup



Tools Menu
This is a customizable menu which allows you to add your own tools and show or hide toolbars
in TELECOMponent.

When you add tools to the menu, they will appear as menu commands below the Toolbars and Customize
commands.

Toolbars ... - Show or hide TELECOMponent toolbars.
Customize ... - Add or remove commands to the Tools menu.



Toolbars

This dialog allows you to turn TELECOMponent toolbars on or off.

With this function, you can arrange toolbars anywhere on the TELECOMponent display.

The Toolbars listbox shows all of the available tool bars.    To change the tool bar status:

1) Select the toolbar you want from the list.
2) Click on [SHOW] to make the toolbar visible or [HIDE] to remove the toolbar from the
display.

If you turn on Tool Tips, a brief description of each tool is shown when you leave the mouse cursor over 
its icon for one second.



Customize

In Tools Menu Customization, you add new commands to the Tools menu.

A tool is a program or command external to COMponents, which you may want to use while in 
COMponents.    You may customize the Tools menu using this dialog to add any programs you like.

The customize dialog includes the following areas:

Menu Items:

Listbox - Contains a list of your added tools.

New - Add a new tool.
Remove - Delete the selected tool.
Move Up - Moves the list up.
Move Down - Moves the list down.

Tabs:

General - Basic information for the added tool. 
Window - Defines the size and position, etc. for the tool window. 
Console - Defines a color scheme for the tool window. 
Options - Other items that define the behavior of the tool. 



View Menu

Normal View
Mailbox View
Status View
Dialer View



Normal View

Selecting this option positions the splitter bars in the TELECOMponent window at default positions 
enabling you to see the Mailbox/Log View, VoiceMail Status View, and Dialer View all at the same time.

Note:    You can change the size of the panes by clicking the LEFT mouse button on a splitter bar and 
dragging it to the desired position.



Mailbox View

Selecting this option positions the splitters so that the entire TELECOMponent Window is occupied by the
Mailbox/Log View.

Note:    You can change the size of the panes by clicking the LEFT mouse button on a splitter bar and 
dragging it to the desired position.



Status View

Selecting this option positions the splitters so that the entire TELECOMponent Window is occupied by the
VoiceMail Status View.

Note:    You can change the size of the panes by clicking the LEFT mouse button on a splitter bar and 
dragging it to the desired position.



Dialer View

Selecting this option positions the splitters so that the entire TELECOMponent Window is occupied by the
Telephony Dialer and Keypad View.

Note:    You can change the size of the panes by clicking the LEFT mouse button on a splitter bar and 
dragging it to the desired position.



Window Menu

Cascade
Tile Horizontally
Tile Vertically
Arrange Icons



VoiceMail/Telephony/Paging Error Codes

300 -- Modem initialization failed.
301 -- Modem not turned on.
302 -- Failed to configure COM port.
303 -- No remote answer.
304 -- No local dialtone.
305 -- No carrier.
306 -- Remote line busy.
307 --User cancelled operation.
308 -- Unable to communicate with paging service.
309 -- Paging service Login failed.
310 --Paging service timed out in protocol.
311 -- Paging service failed to acknowledege paging data.



Error 300: Modem Initialization Failed
Problem:

Your modem could not be intialized properly for VoiceMail.

Solution:
Check to make sure you modem is turned on if it is an external model.    Also check to make sure 
that the line and COM port associated with the modem are accurate.    Check the options in the 
line/modem configuration dialog (accessable from the Options menu) to ensure that the 
appropriate modem settings are enabled.

Finally, make sure that the line is based on a configuration file that matches or is compatible with 
your modem.



Error 301: Modem Not Turned On
Problem:

Your modem could not be intialized properly for VoiceMail, it may be turned off.

Solution:
Check to make sure you modem is turned on if it is an external model.    Also check to make sure 
that the line and COM port associated with the modem are accurate.    Check the options in the 
line/modem configuration dialog (accessable from the Options menu) to ensure that the 
appropriate modem settings are enabled.

Finally, make sure that the line is based on a configuration file that matches or is compatible with 
your modem.



Error 302: Unable To Configure COM Port
Problem:

The COM port could not be properly configured to send the page or initialize VoiceMail.

Solution:
Make sure that if you are sending a page, the COM port settings are supported by your modem.    
Try sending the page again.    If the error continues to occur you may have a hardware problem 
with your serial port or internal modem.    Check your owners manual to ensure that the modem is
configured properly and that there are no IRQ or COM port confilcts on your machine.



Error 303: No Remote Answer
Problem:

The paging service never answered the phone.

Solution:
Resend the page.    You may adjust the number of times the TELECOMponent will attempt to 
redial a page number when it does not answer.

See Also:    Phone List Record - Special Tab



Error 304: No Local Dialtone
Problem:

Your modem did not detect a dialtone prior to dialing.

Solution:
Make sure that your phone line is plugged into the proper jack on the back of your modem.    
Usually there are two RJ-11 phone jacks:    
TELCO which is used to connect another phone through your modem
LINE which is where the phone line should be plugged in. 

See Also:    Phone List Record - Special Tab



Error 305: No Carrier
Problem:

After dialing, the paging service answered but the two modems were unable to establish a 
communications link.

Solution:
Unusually high levels of “noise” on the phone line can often cause this to occur.    Try sending the 
page again.    If the problem persists, there may be a problem with your phone service.

See Also:    Phone List Record - Special Tab



Error 306: Remote Line Busy
Problem:

The destination was busy each time connecting was attempted.

Solution:
Re-schedule the event for when the line is not busy.    You may also increase the number of 
retries when a line busy through the Special Tab in the phone list record.

See Also:    Phone List Record - Special Tab



Error 307: User Cancelled Operation
The operation was abruptly terminated on the local modem when the user clicked the Abort 
button in the status window.



Error 308: Pager Service Attention Failed
Problem:

A communications link was successfully established with the paging service, however, the service
did not respond.

Solution:
Check with your paging service provider and make sure that you have the appropriate COM port 
settings (i.e. Baud Rate, Parity, Data Bits) configured in the phone record that you using to send 
the page to.    Try resending the page.

Also, ensure that the proper settings for AlphaNumeric paging are configured in the phone record.



Error 309: Pager Service Login Failed
Problem:

The paging service provided was successfully contacted, however, login failed.

Solution:
Make sure that your Pager ID and Password (if any) are properly setup in the phone list record 
you are paging to.    Check the settings in the phone record.    Try resending the page.



Error 310: Pager Service Transaction Timeout
Problem:

A communications link was successfully established with the paging service, however, part way 
through the page, the service stopped responding.

Solution:
Try resending the page.    Check the COM port settings for the phone record you are paging to 
and make sure that they are compatible with those that your paging service provider requires.



Error 311: Too Many NAKS from Pager Service
Problem:

A communications link was successfully established with the paging service, however, part way 
through the page, the service refused to accept information being sent to it.

Solution:
Poor line quality might be the culprit.    Try resending the page.



Dialer Menu
Make Call...
Answer Call
Hang Up Flash
Mute
Hold
Do Not Disturb
Wait
Send Fax Now...
Create/Edit PhoneBooks
Access PhoneBooks
Access Logs
Enable Telephony Answer
Speed Dial Setup...
Settings...



Make Call
Selecting this menu option allows you to make an outbound telephony call.

See Also:    Dial Dialog



Answer Call
This option causes the line to be picked up and the normal answer sequence is initiated.



Hang Up
If a Telephony call is in progress, selecting this option hangs up the phone connection and causes an 
entry to be logged into the current default mailbox.



Flash
If a Telephony call is in progress, selecting this option Flashes the phone.



Mute
Select this option to mute/un-mute the microphone of speaker phone when online with a telephony call.

Note:    Your hardware must support this functionality for this option to work!



Hold
Select this option to place the active call on hold or off hold.

Note:    Your hardware must support this functionality for this option to work!



Do Not Disturb
Select this option to disable local sounds.

For example:    With this option turned on, any local operator pages requested by incoming VoiceMail calls
will be suppressed.



Wait
Select this option to prevent the VoiceMail system from answering any incoming calls.

When this option is turned on, the phone will be allowed to ring and will never be automatically answered.



Send Fax Now
Select this option to add a new fax to the schedule queue for sending.    This option will not allow you 
send a fax out on the same call!    To do this you will have to manually dial the number and select the 
“Manual Dial” option from the Fax Wizard.

See Also:    Send Fax Dialog



Create/Edit PhoneBooks

This dialog is used to create and maintain phone lists; it consists of three sections:

Phone Lists Window - shows existing phone lists you previously created and allows you to 
delete and reorder them and create new ones.

Fields Tab - for changing the structure of a phonelist database.

Options Tab - for changing the way a phonelist is displayed.



Access PhoneBooks

This dialog is for maintenance of records within the phone lists you have created.    Use this dialog to add 
or edit new records and groups.



Access Logs

Use the logs to view information about all previous VoiceMail/Fax/Data and Paging operations.    This is a 
convient dialog to access when you want to view, print, or re-send any sent or received fax file 
documents.    You can also view detailed information about any particular log entry, including the type of 
error that occurred if any.

This dialog can be re-sized.    The size and position is retained from session to session.

See Also:    MailBox/Log Access



Enable Telephony Answer
When this option is toggled on, speaker phone calls will be automatically answered if the VoiceMail auto-
answer is not enabled.    If VoiceMail Answer is enabled, it always takes priority to Telephony answer.

Note:    Your hardware must support this functionality for this option to work!



Speed Dial Setup
This tabbed dialog allows you to create and modify speed dial lists.

Unlike other software packages that limit the total number of speed dial lists and/or entries that you can 
create, TELECOMponents allows you to create an unlimited number of speed dial lists each containing an
unlimited number of entries.    For example, you can create a speed dial list consisting of only business 
numbers and another consisting of only personal numbers.    Only one list can be selected in the Dialer 
Keypad View at any one time, but by using the convenient drop down combobox, you can switch between
lists and any time.

Upon selecting the list you would like to use, you are presented with a list of all of the phone records that 
you have added to that particular speed dial list.    An unlimited number of records can be added to each 
speed dial list.

Creating a New Speed Dial List

1. Select the “New...” button on the Speed Dial Setup tabbed dialog.
2. You will be prompted to enter a unique description of the list being created.    Enter a name 

that describes the list, for example, “Business Numbers” or “Personal Numbers.    See 
Speed Dial List Description

3. Use the “Entries” and “Options” tabs to specify the contents of the list you just created.
-OR-

1. If you already have an existing list, you can duplicate the entire list by selecting the list you 
wish to duplicate from the “Speed Dial Lists:” list box, then click the “Duplicate” button.

2. You will be prompted for a unique description (See Speed Dial List Description) of the new 
list.

3. You now have an exact duplicate speed dial list.    You can add or remove entries as 
desired.

Deleting an ExistingSpeed Dial List

1. Highlight the list you wish to delete from the “Speed Dial Lists:” list box on the left side of 
the dialog.

2. Click on the “Delete” button.    This will permanently remove the list from your system.

There are 2 tabs used to define and create speed dial lists in this dialog:

Entries - Add/Remove phone records to the selected speed dial list.
Options - Change the speed dial list description and sorting order..



Telephony Settings
This tabbed dialog allows you to modify settings related to VoiceMail/Telephony operations.    This dialog 
works like many other dialogs in COMponents.    When in advanced mode, you can select from all open 
documents using the list box on the left of the dialog.    By selecting more that one item in the list, you can 
modify settings for more than one document simultaneously.

The Model Telephony entry represents the “default” settings that will be used when “New” documents are 
created.

There are 2 tabs in this dialog:

Telephony - Select the line/port to associate with the selected document.    Also select the 
“default” mailbox to use for logging of Telephony related operations.

General - Configure general VoiceMail/Telephony options.



Dial Dialog
Use this dialog to specify a number to dial for outbound Telephony calls.    A list of the last 10 dialed 
numbers is maintained from session to session for easy re-dialing.    Also the list of previously dialed 
numbers is shared with the “Number To Dial” drop-down combo box in the Dialer/KeyPad view.

Modify entries in the Redial Options group to specify how and when a number should be redialed if the 
number is busy, or if there is no answer.

For hardware that supports Speaker Phone capability, the speaker phone will be enabled.    Otherwise 
your modem is used as a “dumb” dialer to dial the number.    Once the modem has dialed the number, you
will be prompted to pick up your hand-set to continue the call.



Speed Dial Setup - Entries Tab
This Tab consists of two distinct areas and is designed to allow existing phone list records to be easily 
added to speed dial lists:

The Phone List Area - Provides access to all existing phone books.
The Speed Dial Entries Area - Allows you to add/remove phone list records from the speed dial 

list and specify exactly which phone number from the 
corresponding phone list record is to be used when speed 
dialing.

The Phone List Area

All available phone lists are displayed in individual tabs.    To access a particular phone list, simply click on
the tab containing the description of the phone list you would like to access.

Once you have selected the list you wish to work with, you can Add new records, Edit existing records, or 
create temporary records.    Temporary records are NOT added to the phone list.    They are only added to 
the speed dial list and cannot be edited once they are created.

Note: Adding new records to the phone list will not automatically add them to the speed dial list.    
However, any edits to phone list records that are also speed dial list entries WILL be picked up by
the speed dial list.    So if you modify the phone number in a phone record, this new number will 
be picked up when you try to speed dial that number by using the speed dial list.

The Speed Dial Entries Area

All records that have been added to the speed dial list are displayed in this area.    Records can be added 
in four separate ways:

1. Double-click on the record you would like to add from the Phone List Area.    The record will 
be automatically added to the list of speed dial entries. 

2. Highlight the record you wish to add in the phone list, then use Ctrl-Left-Click to drag-and-
drop the record you wish to add from the phone list to the speed dial entries list box.    Note: 
You can also drag-and-drop entire groups from the phone list as well.

3. Select the “Quick Record” button in the phone list area to add a record only to the speed 
dial list and not add it to any phone list.    See also Temporary Speed Dial Entry

4. Highlight the record or group you wish to add in the phone list, then select the “Add Record”
or “Add Group” buttons.

Records can be removed from the “Speed Dial Entries” list box by double-clicking them or selecting them 
and clicking on the “Remove Entry” button.

What Number Gets Dialed By The Speed Dialer?

Once a record has been added to the speed dial list there are several options that are available with 
determine exactly how the speed dial entry will be dialed.

Each phone record can contain multiple phone numbers (e.g. Home1, Home2, Business1, etc.).    To 
specify the number from the phone record that you would like to be dialed when using the speed dialer, 
select the proper number from the “Number To Dial” combo box.    Once you have selected the number, 
the number as it will actually be dialed based upon the current location settings, will be displayed in the 
“Dialable Number” field.

There are 3 special options in the “Number To Dial” combo that can be used as well:



Pager -- When selected as the Number To Dial, then speed dialing the entry will
actually attempt to queue and send a page to the specified number.    
The content of the page is controlled by how the paging options are 
setup in the phone list record.

User Defined -- Allows you to specify a “hard-coded” number to dial.    The number is 
speed dialed exactly as it is entered.

Prompt When Dialing -- Causes a dialog box to be displayed when speed dialing which allows 
you to choose which number you wish to speed dial on-the-fly.



Speed Dial Setup - Options Tab
This tab allows you to modify the description of the selected speed dial list.    It also allows you to specify 
the order in which the entries are sorted when displayed in the Speed Dial List box.    The entries are 
always sorted based upon the “Name” field of the phone list record.

To change the description, simply type in a new unique description for the speed dial list.

To change the sorting order, simply click on the order in which you would like the list displayed.



Speed Dial List Description
This dialog allows you to specify a unique description for a New or Duplicated speed dial list.    You will not
be allowed to enter a non-unique description

When duplicating lists, a unique name based on the original list name will be created for you.



Telephony Settings - Telephony Tab
Use this tab to configure the line/port to which the selected documents are to be connected.    Be sure that
any line you select to associate with your TELECOMponent documents is capable of VoiceMail 
functionality.

You may also modify settings for the modem that the current document is currently connected to by 
selecting the [Configure...] button.

Also, use the InBox and OutBox combo boxes to select which default mailbox you wish to associate with 
the currently selected line.    The default mailbox is the mailbox to which outbound and inbound telephony 
calls are logged.

See Also:    Configure Line/Modem



Telephony Settings - General Tab
Use this tab to configure general options for the selected document(s).

If “Automatically Save Telephony Settings” is checked, any changes to the settings for the selected 
document(s) will be saved without prompting the user when the document is closed.    If it is unchecked 
and settings change, the user will be prompted with a “Save” dialog when trying to close down the 
document window.

VoiceMail can store a detailed Call Event History for Inbound VoiceMail calls.    This feature allows you to 
review, in detail, exactly what actions a caller took while on-line with the VoiceMail system.    It is important
to note that with this feature enabled, more disk space will be occupied for VoiceMail log entries.    This 
feature is enabled by default, uncheck this option if you do not want detailed logging.



Quick Speed Dial Record
Filling out the fields in this dialog to complete a temporary record that will be stored in the speed dial list.

For proper dialing, you should be sure to complete the “City/Area Code”, “Number”,    “Name”, and 
“Country” fields.

Note: The new record will be added to to speed dial list only, NOT the phone list.



VoiceMail Menu

Play
Play New
Forward...
Archive
Un-Archive
Delete
Record Memo...
Record Greeting...
Enable VoiceMail Answer
Mailbox Setup...
Voice System Setup...



Play
This option “Plays” all of the currently selected log entries.    You may select one or more log entries from 
the Log/Mailbox View of the active TELECOMponent window and execute the play function automatically 
for each entry by selecting this option.

Log entries of different types interpret “Play” differently.    For VoiceMail log entries, any messages left by 
callers are played.    For Fax log entries, any received faxes are viewed.    Note that some log entry types 
do not support the concept of “Play” at all.

Note:    This option is not available from the menu in Novice Mode.    You must access the log dialog to 
use this function.



Play New
This option “Plays” all of the NEW log entries.    Log entries are considered to be NEW if their status is not
“Viewed”.    This option is useful if you want to view, in sequence, all entries that have been logged on 
your system since the last time you checked.

Log entries of different types interpret “Play” differently.    For VoiceMail log entries, any messages left by 
callers are played.    For Fax log entries, any received faxes are viewed.    Note that some log entry types 
do not support the concept of “Play” at all.

Note:    This option is not available from the menu in Novice Mode.    You must access the log dialog to 
use this function.



Forward
This option is enabled if there are any selected log entries in the Log/Mailbox View.

Use this option to copy logged entries to one or more other mailboxes.    You can also copy logged entries
by Ctrl-Left-Click and dragging them from one mailbox and dropping them onto a different mailbox.    
Entries can be “moved” by just performing a Left-Click and drag (no Ctrl).

Note:    This option is not available from the menu in Novice Mode.    You must access the log dialog to 
use this function.

See Also:    Forward Log Entry



Archive
This option is enabled if there are any selected log entries in the Log/Mailbox View.

Use this option to move logged entries to the Archive folder of the mailbox in which they reside.
Archiving provides a mechanism that you can use to separate log entries that you would like to hold on to 
from new incoming entries.

Note:    This option is not available from the menu in Novice Mode.    You must access the log dialog to 
use this function.



Un-Archive
This option is enabled if there are any selected log entries in the Archive folder of the Log/Mailbox View.

Use this option to move logged entries from the Archive folder of a mailbox back into the associated InBox
or OutBox folders.

Note:    This option is not available from the menu in Novice Mode.    You must access the log dialog to 
use this function.



Delete
This option is enabled if there are any selected log entries in the Log/Mailbox View.

Use this option to delete logged entries from the MailBox/Log.    Once entries are deleted they cannot be 
retrieved.    All temporary files (including received fax files) will be deleted along with the log entry.

Note:    This option is not available from the menu in Novice Mode.    You must access the log dialog to 
use this function.



Record Memo
This option allows you to record a memo which will be logged to the current default InBox.    The default 
InBox is specified in the Telephony Tab of the Settings Dialog.



Record Greeting
This option allows you to record the greeting for the default mailbox that will be played when a called 
phones in.    This option is provided to allow you to easily change the greeting.    The default mailbox is 
specified in the Telephony Tab of the Settings Dialog.



Enable VoiceMail Answer
When this option is toggled on, the VoiceMail system will answer any incoming calls.    VoiceMail has 
higher prority than fax or data.    If the incoming call if a voice call, the user will be immediately prompted 
with the system greeting.    If the call is a fax, it will be received.    If it’s a data call it will be connected.    
Note that to answer for fax or data, a FAXCOMponent or DATACOMponent window will need to be 
running.



Mailbox Setup
This tabbed dialog allows you to create, delete, and modify mailboxes.
There is no practical limit on the numbe of mailboxes that you can create and have active.

This dialog works like many other dialogs in COMponents.    There are two areas:

The Mailbox List Area - Displays the existing mailboxes.    Allows you to choose which 
mailbox you will be modifying settings for or deleting.    Also 
allows you to create and delete existing mailboxes.

Note:    You cannot delete mailbox number zero.    You can, however, modify its settings. 

Mailbox Settings Tabbed Area - Allows you modify the settings for the selected mailbox..

There are 6 tabs in this dialog:

Name - Specify the name of the mailbox, give it a description, and/or assign a 
password to the mailbox.

Settings - Select the basic options for the mailbox.
Limits - Specify the maximum length of messages, etc. that can be stored in this 

mailbox..
Notification - Configure options for notification when messages or faxes are left in the 

selected mailbox.
Fax-on-Demand - Configure Fax-on-Demand lists and documents that are private to the 

selected mailbox.
Remote Access - Configure options and password for remote message retrieval and 

mailbox access.



Mailbox Setup - Name Tab
This tab displays information related to the identification of the selected mailbox.

Each mailbox must be assigned a unique number.    Mailbox 0 is created be default and cannot be 
deleted, however, it can be renamed.

The full path where inbox and outbox files are stored is displayed.    This path is hard-coded and defined 
by the mailbox number.    Using this scheme allows you to specify a descriptive name to the mailbox and 
not have to worry the mailboxes location on your hard drive.

You may also enter a description and owner for the mailbox.

By selecting “Require Password To Access Mailbox” and specifying a password, VoiceMail callers will be 
automatically prompted and required to enter a password when trying to access the mailbox.



Mailbox Setup - Settings Tab
This tab allows you to modify basic settings that govern how the mailbox behaves when it is accessed by 
a VoiceMail caller.

You can specify whether or not the mailbox will allow callers to leave messages, and the recording quality
of the messages.

You can also specify whether or not the operator paging option will be available for this mailbox.    When 
enabled, a VoiceMail caller will be able to cause the system to beep, alerting the operator to his presence.

Play Mailbox Greeting
When enabled, plays a personalized greeting when a VoiceMail caller accesses the mailbox.    
For your convienience, a primary and secondary greeting can be recorded.    You can then easily 
switch between the two by selecting the appropriate radio button.

Play Informational Message
When enabled, the VoiceMail caller will be given a menu option to playback the informational 
message.

Recording of Mailbox Name as it is Spoken
The VoiceMail system uses this recording to identify your mailbox by name to a caller.

Note:    All messages in this dialog can be recorded by selecting the [...] button.    The paths of the 
messages are displayed in read-only edit fields so that you can scroll to see the full path of the message.  
These paths are determined by the software and cannot be modified through these edit fields.



Mailbox Setup - Limits Tab
Use this tab to implement limitations on the length and/or size of voice messages that callers can leave.

You can also limit the quantity and size of faxes that are received.

Once these limits have been established no more messages or faxes will be allowed.

To allow unlimited messages and faxes set all values to 0.



Mailbox Setup - Notification Tab
Use this tab to specify remote pager notification of received messages and faxes.

You can specify a list of pagers to be notified separately for messages and faxes.

Select the Setup... button to create or modify pager lists.    Pager list setup is nearly identical to Speed 
Dial List setup.    See Speed Dial List Setup for more information on how to configure lists of pagers.

You can also specify local notification of incoming messages or faxes via playing a wave file.



Mailbox Setup - Fax-on-Demand Tab
This tab allows you to enable private Fax-on-Demand for the selected mailbox.    When enabled, the caller
will be given a voice menu option allowing them to access and retrieve the Fax-on-Demand documents 
that you have configured using this tab.

You can create an unlimited number of Fax-on-Demand lists, which can each contain an unlimited 
number of documents.

Use this tab to select the list you want to be active through the VoiceMail system.
The list box displays all of the documents contained in the currently selected list and is for informational 
purposes only.

To create, delete, or modify Fax-on-Demand lists, select the Setup... button.

For more information on Fax-on-Demand List setup see Fax-on-Demand Setup.



Fax-on-Demand Setup
This tabbed dialog allows you to create, delete, and modify Fax-on-Demand lists.

Unlike other software packages that limit the total number of Fax-on-Demand lists and/or documents that 
you can create, TELECOMponents allows you to create an unlimited number of Fax-on-Demand lists 
each containing an unlimited number of fax documents. Only one list can be selected at a time for each 
mailbox, however, by using the convienient drop down combobox, you can switch between lists and any 
time.

Creating a New Fax-on-Demand List

1. Select the “New...” button on the Fax-on-Demand Setup tabbed dialog.
2. You will be prompted to enter a unique description of the list being created.    Enter a name 

that describes the list.    See the Descripton Dialog.
3. Use the “Documents” and “Options” tabs to specify the contents of the list you just created.

-OR-
1. If you already have an existing list, you can duplicate the entire list by selecting the list you 

wish to duplicate from the “Lists:” list box, then click the “Duplicate” button.
2. You will be prompted for a unique description.
3. You now have an exact duplicate Fax-on-Demand list.    You can add, remove or modify 

documents as desired.

Deleting an Existing Fax-on-Demand List

1. Highlight the list you wish to delete from the “Lists:” list box on the left side of the dialog.
2. Click on the “Delete” button.    This will permanently remove the list from your system.

There are 2 tabs used to define and create Fax-on-Demand lists in this dialog:

Documents - Add/Remove fax documents to/from the selected Fax-on-Demand list.
Options - Change the Fax-on-Demand list description.



Fax-on-Demand Setup - Documents Tab
This tab consists of three distinct areas and is designed to allow existing fax documents to be easily 
added to Fax-on-Demand Lists:

The Documents Area - Use the Add and Remove buttons to add or remove 
preconverted fax documents to/from the selected Fax-on-
Demand list.

The Document Information Area - Specify a unique number for the selected document.    
Also specify a text description for the document and reset the 
access information on the selected document.

The Retrieval Options Area Specify whether or not retrieval is allowed, whether a password 
is required, and a message to play to the caller when the 
document is selected for fax back.

The Documents Area

All documents currently in the selected list are displayed in the list box.    A yellow check next to the 
document means that it is will be available for fax back through the VoiceMail system.    Use the Add and 
Remove buttons to modify the content of the list.    Note that you may only add pre-converted fax 
documents (.CPF).
The currently selected document in this area is used to populate the information of the other two areas.

The Document Information Area

All documents that are added have a unique number assigned to them.    Additionally, you can specify a 
text description for the document.

Use the Reset button to reset access information for the selected document.

The Retrieval Options Area

The allow document retrieval option allows you to enable/disable the ability of a user to retrieve the 
document without having to remove it from the list altogether.

By specifying a password, the caller will be prompted to enter the password before he will be allowed to 
retrieve the document.

Finally, you can record a message that will be played for the user when he selects the document for 
retrieval.



Fax-on-Demand Setup - Options Tab
This tab allows you to modify the description of the selected Fax-on-Demand list.

To change the description, simply type in a new unique description for the Fax-on-Demand list. 

You may also record a voice message that describes the currently selected list.    This message will be 
played to the caller when he is accessing the Fax-on-Demand Voice Menu.



Mailbox Setup - Remote Access Tab
Use this tab to enable the types of operations that will be allowed when dialing into the system from a 
remote location.

You can also specify that remote access only be allowed upon entering the appropriate password.    You 
can use the same password that you selected in the Mailbox Settings Name Tab or define a new, 
separate one.



Voice System Setup
This tabbed dialog allows you to modify settings that are global to the VoiceMail system, rather than 
specific to a particular mailbox.    To modify settings for an individual mailbox see Mailbox Setup.

There are 7 tabs in this dialog:

System - Configure basic VoiceMail system settings.
Mailbox - Select the basic message related options for the mailboxes.
Line - Configure line related settings such as input and output volume.
Settings - Configure settings related to message recording and document retrieval.
Prompts - Configure and/or record the prompts that the VoiceMail system will use.
Quick Fax - Select a single fax document that will be made available for retrieval by 

people calling in.
Fax-on-Demand - Configure Fax-on-Demand lists and documents that are available to the 

caller without having to be in a specific mailbox.



Voice System Setup - System Tab
Use this tab to specify basic behavior of the VoiceMail system.

The Remote Access Options define parameters used to determine when to automatically hang up on a 
caller.

If Mulitple mailboxes exist, you can have the VoiceMail system play an additional prompt.    This becomes 
the very first prompt played when a caller calls in.



Voice System Setup - Mailbox Tab
The mailbox options on this tab allow you to define overriding values for number of messages, message 
length, and disk space used.

If the values in a mailbox exceed the values listed here, the values listed here take precedence.



Voice System Setup - Line Tab
Use this tab to specify settings related to the voice line.

Use caller ID enabled, to enable caller ID processing.    When caller ID processing is enabled the name 
and phone number of the incoming call is displayed in the status window if the phone line support caller 
ID.

Enabling monitor incoming call cause the current phone call to be played audibly so you can listen in.    
Note that this feature is only functional if your hardware supports it.

When toll saver is enabled, the phone will answer on 2 additional rings regardless of the number of rings 
to answer that is setup in Line/Modem Setup.    Note that when toll saver on, the phone will not answer in 
fewer than 2 rings!

Auto-detect remote hangup is disabled by default.    If your hardware supports this feature, the VoiceMail 
system will reset immediately when the remote caller hangs up.    Otherwise the system waits for the 
timeout periord or uses silence detection to determine that the remote caller has hung up.    Note that this 
feature may be unreliable under certain conditions even if the hardware supports it.    If your callers are 
being hung up on by the VoiceMail system, turn this option off.

You can set the volume levels that are used when playing and recording voice messages over the phone 
line.



Voice System Setup - Settings Tab
Use this tab to specify the sound quality of recorded messages.    The higher the quality the more disk 
space is consumed for messages.

Silence detection level allows you to specify how sensitive your modem is to silence.
Silence duration allows you to specify how many seconds of silence are required before it is detected as 
silence.

The document retrieval options allow you to specify the behavior of the VoiceMail system when the user is
negotiating the Fax-on-Demand menus.



Voice System Setup - Prompts Tab
Use this tab specify the mode in which the VoiceMail system runs and to record all of the prompts and 
menus that the VoiceMail system uses while it is running.

The “Use Advanced Mode Prompts” checkbox determines how the VoiceMail system runs.

The VoiceMail system runs in two disinct modes:
Simple Mode -- Acts like a very simple answering machine.    Plays a single greeting and 

immediately goes into record mode to record a message.
Advanced Mode -- Provides complete and comprehensive VoiceMail functionality including 

support for multiple mailboxes and Fax-on-Demand.

You can select the language that the VoiceMail system uses if you have recorded prompts in each 
language.

The message prompt level determines verbosity of the messages to be used.

You can record messages for all languages and all verbosity levels if you wish and use this dialog to 
specify which one you want the VoiceMail system to use.

See Also:    Record Message Prompts



Voice System Setup - Quick Fax Tab
Use this tab to select a single pre-converted (.CPF) fax document and make it available through the 
VoiceMail system.

Quick Fax is an option on the main system menu in the voice tree when running in advanced mode.



Voice System Setup - Fax-on-Demand Tab
Use this tab to specify which Fax-on-Demand list you wish to be available from outside of any mailbox 
when running in advanced mode.

For more information on configuring Fax-on-Demand Lists see Fax-on-Demand Setup.



Record Message Prompts
This dialog allows you to record all message prompts that the VoiceMail system plays when somebody 
calls in.

Unlike many other products, you can maintain different groups of prompts for different languages.    
Simply select the language that you will be using when recording the prompts.    You can then select in 
which language the VoiceMail system will run.    See the Voice System Setup - Prompts Tab for more 
information.    Also prompts of 3 distinct levels of verbosity can be recorded.    You can then select which 
level of verbosity will be used by the VoiceMail system.

The “Show Unrecorded Prompts” checkbox allows you to quickly see which prompts have not yet been 
recorded.    The unrecorded prompts are displayed in the “Prompt” combo box.

Each prompt that the VoiceMail system requires is displayed along with suggested text for the prompt in 
the “Prompts” section of the dialog.    We suggest you run through and record all of the prompts in one 
sitting.

The Play/Record control area allows you to control recording and playback of the currently selected 
prompt.

The input and output volume and devices can be selected using the slider controls and the toggle buttons 
which step through all of the hardware devices supported by the current line.



Record Dialog
Use this dialog to record specific prompts, memos or greetings.    You can modify the input and output 
volume and devices.



Play Back Dialog
Use this dialog to play back previously recorded messages.    Use the volume controls to specify output 
volume and to control the output device used for playback.



Description Dialog
This dialog allows you to specify a unique description for a New or Duplicated Fax-on-Demand list.    You 
will not be allowed to enter a non-unique description.

When duplicating lists, a unique name based on the original list name will be created for you.



VoiceMail System Working Specification

Abstract
The purpose of this document is to describe some of the characteristics of the voice tree, its menu 
structure and its operation.      Also, some of the design decisions are documented.

Acronyms and Abbreviations
DTMF Dual-Tone Multiple-Frequency - Touch tones from the phone.
PCIN Personal Caller Identification Number
FOD Fax-On-Demand

Documentation Notes:
· DTMF selections which are unavailable in the initial release have been marked with 

underlined text.

Limitations
1. Once the voice tree has switched to a non-voice mode, it will not switch back to a voice mode.      For 

example, once the voice tree has begun receiving a fax or sending a fax, the termination of the fax 
operation will result in the termination of the call.

1. The system has two distinct access modes for Fax-On-Demand.      The Global Fax-On-Demand set is
accessed directly from the Main System menu and is a set of document lists shared by the entire 
system.      A Private Fax-On-Demand set of document lists is accessed only after entering a specific 
Mailbox menu.      The caller can not directly switch between different Private Fax-On-Demand sets, 
he must exit the current mailbox and then enter a different mailbox to select a different Private Fax-
On-Demand set.

Fax-On-Demand Document Hierarchy
The Fax-On-Demand documents are grouped into lists, and the lists are grouped into a set.      This offers 
the system administrator a second grouping level.      Each document can have its own descriptive voice 
message.      Each list has can have its own descriptive voice message and document index.      The set 
index is automatically generated by compiling the descriptions of each list item into a text file and then 
converting the text file to a fax file.      The message is generated by playing each list descriptive message 
in sequence until complete or canceled by the caller.      There is one Global Fax-On-Demand set and 
each mailbox can have a single Private Fax-On-Demand set.      There will not be any provision to select 
different sets.    The Global Fax-On-Demand and each Mailbox Fax-On-Demand will have only one set.      
Each set, however, can have one or more lists; only one list can be selected as the default list.    See Fax-
on-Demand Setup for more information on configuring Fax-on-Demand lists.

Voice Tree Operating Modes
The voice tree can be in one of several operating modes at any particular time.      The modes listed here 
are not in any particular order, nor are the transitions from one mode to another listed.
1. Playing message file.      The voice tree is currently playing a message file.
2. Recording message file.      The voice tree is currently recording a message file.
3. Get next action.      The voice tree is currently waiting for the caller to indicate which action should be 

taken next.
4. Get caller input.      The voice tree is waiting for caller input, such as a numeric entry or a password.



Voice Tree Menu Structure Specification
The voice tree is traversed by caller-initiated action and actions automatically invoked if the time 

out period elapses.      The actions correspond to DTMF tones entered from the caller’s handset. In a later 
release, the system will also respond to keyboard equivalents for DTMF commands, so that the user’s 
configuration of the system can be tested locally.

Where possible, the ‘STAR’ button has been reserved to mean replay prompt or else to mean 
cancel operation, so that the user can readily obtain help or escape from the current action.

The voice tree can be run in 2 distinct modes:

Simple answering machine mode
Advanced voicemail system mode

See the Voice System Setup - Prompts Tab on how to configure the system for simple vs. advanced 
mode.

Simple Mode Voice Tree
Menu : SimpleSystem
The Simple System menu is the default configuration when the system    is first installed.    This menu 
greets the caller with the system mailbox greeting message and then prompts them to wait for the beep to
leave a message.      After the system begins recording, the recording will automatically be saved if the 
user disconnects from the system or if the user stops talking for the quiet detection period..      The 
message will be recorded and logged into the system mailbox.      Since the space on the floppy disks is 
limited, only a single prompt file is supplied.    The retrieval of faxes or messages from remote is not 
possible when the Simple System menu is active.

Prompt File
Event Action

DTMF 1 Record message into ‘system’ mailbox
DTMF 2
DTMF 3
DTMF 4
DTMF 5
DTMF 6
DTMF 7
DTMF 8
DTMF 9
DTMF 0
DTMF *
DTMF #
Time Out Record message into ‘system’ mailbox
Fax Tone Receive fax to ‘system’ mailbox
Data Tone Negotiate data call and receive data files to ‘system’ mailbox

Advanced Mode Voice Tree
Menu : Main System
The Main System menu is the first menu presented after the primary system greeting has been played.      
This menu is optional, and if it is disabled, it is assumed that the user will provide the caller with relevant 
prompt information in the primary system greeting message.      If the main system menu times out, the 
tree will assume that the caller is not calling from a touch-tone phone, so the tree will go into message 
record and will optionally post an alert to the local operator.

Prompt File
Event Action



DTMF 1 Record message to system mailbox
DTMF 2 Access specified Mailbox menu
DTMF 3 Switch to fax file receive mode
DTMF 4 Transmit any queued fax documents now
DTMF 5 Switch to data call / host mode
DTMF 6 Access Global Fax-On-Demand menu
DTMF 7 Access General Setup menu
DTMF 8 Quick fax send (fax poll)
DTMF 9 Quick file download
DTMF 0 Local operator attention
DTMF * Replay Main System menu prompt message
DTMF # Replay system greeting message
Time Out Go to Record Message for ‘system’ mailbox
Fax Tone Receive fax to ‘system’ mailbox
Data Tone Negotiate data call and receive data files to ‘system’ mailbox

Explanations:
· DTMF 1 - Record message to system mailbox
· DTMF 2 - Prompt caller for mailbox number, then run Mailbox menu for specified mailbox.
· DTMF 3 - Caller will immediately transmit a fax file to the system.      System will exit voice tree and 

switch to fax receive mode.
· DTMF 4 - If the caller has queued any fax documents, they will be transmitted to him after this menu 

selection has been made.      This selection will result in exit of the voice tree and a switch to fax 
transmit mode.      After the fax transmission, the call will be terminated.

· DTMF 5 - When we develop data host mode capability, this menu item will switch to the data host 
mode after negotiating a data link.    In the meantime, it will switch to data mode and negotiate a data 
communications session.

· DTMF 6 - Access the Global Fax-On-Demand menu.      Only Fax-On-Demand operations are 
available from this menu.      User must return to Main System menu to do anything else.

· DTMF 7 - Access the General Setup menu.
· DTMF 8 - The system has a pre-designated fax file ready for transmission.      This fax file and feature 

corresponds to the ‘fax polling’ mode of stand alone fax machines.      The FAXCOMponent fax 
protocols should also be modified to support fax polling.      The document transmitted by this feature 
would correspond to the same document transmitted by fax polling.

· DTMF 9 - The system has a pre-designated data file ready for download to the caller.    The 
DATACOMponent Z-Modem file transfer protocol would be used for sending the file after negotiating a
data link.

· DTMF 0 - The caller is paging the local operator.      This feature is unavailable if the local operator has
activated DO NOT DISTURB.

· DMTF * - Replay system greeting message.      If the operator has disabled the main greeting, then the
Main System menu prompt message will be played.

· DTMF # - Replay Main System menu prompt message.
· Time Out - Apparently the caller is incapable of generating DTMF tones, it is an older data modem 

that does not support data calling tones, or an older fax machine that does not generate CNG tones.   
The system will go into ‘answering machine mode’ and record a message into the system mailbox.

Menu : Message Play
The Message Play menu is used to play a message to the caller.      There are no sub-menus.

Prompt File
Event Action

DTMF 1
DTMF 2
DTMF 3
DTMF 4
DTMF 5



DTMF 6
DTMF 7
DTMF 8
DTMF 9
DTMF 0
DTMF * Replay associated voice message
DTMF # Skip remainder of associated voice message
Time Out
Fax Tone Receive fax to ‘current’ mailbox
Data Tone Negotiate data call and receive data files to ‘current’ mailbox

Explanations:
· DTMF 1 - 
· DTMF 2 - 
· DTMF 3 - 
· DTMF 4 - 
· DTMF 5 - 
· DTMF 6 - 
· DTMF 7 - 
· DTMF 8 - 
· DTMF 9 - 
· DTMF 0 - 
· DMTF * - Replay associated voice message so caller can hear it again.
· DTMF # - Skip remainder of associated voice message and go to next action.
· Time Out - 

Menu : Prompt Message Play
The Prompt Message Play menu is used to prompt the caller for the requested input.      There are no sub-
menus.

Prompt File
Event Action

DTMF 1
DTMF 2
DTMF 3
DTMF 4
DTMF 5
DTMF 6
DTMF 7
DTMF 8
DTMF 9
DTMF 0
DTMF * Replay associated prompt message
DTMF # Skip remainder of associated prompt message
Time Out
Fax Tone Receive fax to ‘current’ mailbox
Data Tone Negotiate data call and receive data files to ‘current’ mailbox

Explanations:
· DTMF 1 - 
· DTMF 2 - 
· DTMF 3 - 
· DTMF 4 - 
· DTMF 5 - 
· DTMF 6 - 
· DTMF 7 - 



· DTMF 8 - 
· DTMF 9 - 
· DTMF 0 - 
· DMTF * - Each prompt has its own message.    This option will replay the prompt message.
· DTMF # - Skip remainder of associated prompt message and begin next action.
· Time Out - 

Menu : Play Recording
The Play Recording menu is used to play a message that has been recorded to the caller.      There are no
sub-menus.

Prompt File
Event Action

DTMF 1
DTMF 2
DTMF 3
DTMF 4
DTMF 5
DTMF 6
DTMF 7
DTMF 8
DTMF 9
DTMF 0
DTMF * Replay recorded voice message
DTMF # Skip remainder of voice message
Time Out
Fax Tone Receive fax to ‘current’ mailbox
Data Tone Negotiate data call and receive data files to ‘current’ mailbox

Explanations:
· DTMF 1 - 
· DTMF 2 - 
· DTMF 3 - 
· DTMF 4 - 
· DTMF 5 - 
· DTMF 6 - 
· DTMF 7 - 
· DTMF 8 - 
· DTMF 9 - 
· DTMF 0 - 
· DMTF * - Replay recorded voice message so caller can hear it again.
· DTMF # - Skip remainder of voice message and go to next action.
· Time Out - 

Menu : Simple Record Message
The Simple Record Message menu contains actions that are valid while a simple message record is in 
progress.      If message is canceled, then the ‘recording canceled’ message is played.      If message is 
saved, then the ‘recording saved’ message is played.      There are no sub-menus.

Prompt File
Event Action

DTMF 1 Save recording and exit Simple Record Message menu
DTMF 2 Save recording and exit Simple Record Message menu
DTMF 3 Save recording and exit Simple Record Message menu
DTMF 4 Save recording and exit Simple Record Message menu
DTMF 5 Save recording and exit Simple Record Message menu



DTMF 6 Save recording and exit Simple Record Message menu
DTMF 7 Save recording and exit Simple Record Message menu
DTMF 8 Save recording and exit Simple Record Message menu
DTMF 9 Save recording and exit Simple Record Message menu
DTMF 0 Save recording and exit Simple Record Message menu
DTMF * Erase recording and exit Simple Record Message menu
DTMF # Save recording and exit Simple Record Message menu
Time Out Save recording and exit Simple Record Message menu
Fax Tone Receive fax to ‘system’ mailbox
Data Tone Negotiate data call and receive data files to ‘system’ mailbox
Time Limit Save recording and exit Simple Record Message menu

Menu : Record Message
The Record Message menu contains actions that are valid while a message record is in progress.      
Unless the recording is canceled, the subsequent menu will be Record Message Save.

Prompt File
Event Action

DTMF 1
DTMF 2
DTMF 3
DTMF 4
DTMF 5
DTMF 6
DTMF 7
DTMF 8
DTMF 9
DTMF 0
DTMF * Do not save message and exit Record Message menu
DTMF # Stop recording and go to Record Message Save menu
Time Out
Fax Tone Receive fax to ‘current’ mailbox
Data Tone Negotiate data call and receive data files to ‘current’ mailbox
Time Limit Stop recording and go to Record Message Save menu

Explanations:
· DTMF 1 - 
· DTMF 2 - 
· DTMF 3 - 
· DTMF 4 - 
· DTMF 5 - 
· DTMF 6 - 
· DTMF 7 - 
· DTMF 8 - 
· DTMF 9 - 
· DTMF 0 - 
· DMTF * - Cancel : If not in the simple modes, do not save message and exit Record Message menu.
· DTMF # - Done : If not in the simple modes, stops recording and goes to Record Message Save 

menu.
· Time Out - 
· Time Limit - Done : Stops recording and goes to Record Message Save menu.      If in simple mode 

and the recording was activated by a main system menu time out, this causes a disconnect.      If in 
simplest mode and the recording is complete, this results in a disconnect.

Menu : Record Message Save
The Record Message Save menu contains actions that are valid immediately after a message has been 



recorded and the Record Message Save menu prompt has been played.      Messages are assigned the 
‘Normal Default’ priority.      The caller can toggle to a different priority.      There are no sub-menus.      If 
message is canceled, then the ‘recording canceled’ message is played.      If message is saved, then the 
‘recording saved’ message is played.

Prompt File
Event Action

DTMF 1 Replay recorded message
DTMF 2 Replay original message, if available
DTMF 3 Toggle message priority
DTMF 4
DTMF 5
DTMF 6
DTMF 7
DTMF 8
DTMF 9
DTMF 0 Erase message and exit Record Message menu
DTMF * Replay Record Message Save menu prompt message
DTMF # Save message and exit Record Message menu
Time Out Replay Record Message Save menu prompt message
Fax Tone Receive fax to ‘current’ mailbox
Data Tone Negotiate data call and receive data files to ‘current’ mailbox

Explanations:
· DTMF 1 - Play recorded message to caller and run Record Message Save menu again.
· DTMF 2 - Replay original message, if available.    For example, when recording a new greeting, you 

could go back and listen to your ‘old’ greeting before choosing whether to save or erase the new 
recording.

· DTMF 3 - Toggle priority of the message.    Rotate from ‘Normal Default’ to ‘High Default’ to ‘Low 
Default’ back to ‘Normal Default’.

· DTMF 4 - 
· DTMF 5 - 
· DTMF 6 - 
· DTMF 7 - 
· DTMF 8 - 
· DTMF 9 - 
· DTMF 0 - Cancel : Do not save message and exit Record Message menu.
· DMTF * - Replay Record Message Save menu prompt message.
· DTMF # - Done : Save message and exit Record Message menu.
· Time Out - Replay Record Message Save menu prompt message.

Menu : Get Caller Input
The Get Caller Input menu is invoked when the system requires some input from the caller.      The caller 
is expected to supply DTMF tones.      There are no sub-menus.

Event Action
DTMF 1 Store 1
DTMF 2 Store 2
DTMF 3 Store 3
DTMF 4 Store 4
DTMF 5 Store 5
DTMF 6 Store 6
DTMF 7 Store 7
DTMF 8 Store 8
DTMF 9 Store 9
DTMF 0 Store 0



DTMF * Clear and enter new information
* - * Clear and replay prompt
* - # Cancel

DTMF # Accept / Done
Time Out Clear entry and replay associated prompt message
Fax Tone Receive fax to ‘current’ mailbox
Data Tone Negotiate data call and receive data files to ‘current’ mailbox

Explanations:
· DTMF 1 - Add digit 1
· DTMF 2 - Add digit 2
· DTMF 3 - Add digit 3
· DTMF 4 - Add digit 4
· DTMF 5 - Add digit 5
· DTMF 6 - Add digit 6
· DTMF 7 - Add digit 7
· DTMF 8 - Add digit 8
· DTMF 9 - Add digit 9
· DTMF 0 - Add digit 0
· DMTF * - Clear any existing data and enter information again.
· DTMF # - Done.    If there is no data entry, then it is treated as a cancel.
· Time Out - Clear entry and replay prompt message

Menu : Get Password
The Get Password menu is invoked when the system requires a password from the caller.      The caller is 
expected to supply DTMF tones.      There are no sub-menus.

Event Action
DTMF 1 Store 1
DTMF 2 Store 2
DTMF 3 Store 3
DTMF 4 Store 4
DTMF 5 Store 5
DTMF 6 Store 6
DTMF 7 Store 7
DTMF 8 Store 8
DTMF 9 Store 9
DTMF 0 Store 0
DTMF * Clear and enter new information

* - * Clear and replay prompt
* - # Cancel

DTMF # Accept / Done
Time Out Clear entry and replay associated prompt message
Fax Tone Receive fax to ‘current’ mailbox
Data Tone Negotiate data call and receive data files to ‘current’ mailbox

Explanations:
· DTMF 1 - Add digit 1
· DTMF 2 - Add digit 2
· DTMF 3 - Add digit 3
· DTMF 4 - Add digit 4
· DTMF 5 - Add digit 5
· DTMF 6 - Add digit 6
· DTMF 7 - Add digit 7
· DTMF 8 - Add digit 8
· DTMF 9 - Add digit 9



· DTMF 0 - Add digit 0
· DMTF * - Clear any existing data and enter information again.
· DTMF # - Done.    If there is no data entry, then it is treated as a cancel.
· Time Out - Clear entry and replay prompt message

Menu : Get Phone Number
The Get Phone Number menu is invoked when the system requires a phone number from the caller.      
The caller is expected to supply DTMF tones.    There are no sub-menus.

Event Action
DTMF 1 Store 1
DTMF 2 Store 2
DTMF 3 Store 3
DTMF 4 Store 4
DTMF 5 Store 5
DTMF 6 Store 6
DTMF 7 Store 7
DTMF 8 Store 8
DTMF 9 Store 9
DTMF 0 Store 0
DTMF * Clear and enter new information

* - * Clear and replay prompt
* - # Cancel

DTMF # Accept / Done
Time Out Clear entry and replay associated prompt message
Fax Tone Receive fax to ‘current’ mailbox
Data Tone Negotiate data call and receive data files to ‘current’ mailbox

Explanations:
· DTMF 1 - Add digit 1
· DTMF 2 - Add digit 2
· DTMF 3 - Add digit 3
· DTMF 4 - Add digit 4
· DTMF 5 - Add digit 5
· DTMF 6 - Add digit 6
· DTMF 7 - Add digit 7
· DTMF 8 - Add digit 8
· DTMF 9 - Add digit 9
· DTMF 0 - Add digit 0
· DMTF * - Clear any existing data and enter information again.
· DTMF # - Done.    If there is no data entry, then it is treated as a cancel.
· Time Out - Clear entry and replay prompt message

Menu : Global Fax-On-Demand and Private Fax-On-Demand
The Global Fax-On-Demand (FOD) menu list is accessed from the Main System menu.
The Private Fax-On-Demand (FOD) menu list is accessed from a Mailbox menu.

Prompt File
Event Action

DTMF 1 Add a specified fax to queue
DTMF 2 Remove a specified fax from queue
DTMF 3 Add all faxes in current list to queue
DTMF 4 Play a specified fax description message
DTMF 5 Play all fax descriptions for current list
DTMF 6 Add a fax of faxes available in current list to queue
DTMF 7 Select a different Fax-On-Demand list



DTMF 8 Play descriptive message of available Fax-On-Demand lists
DTMF 9 Add a fax of available Fax-On-Demand lists to queue
DTMF 0 Enter/Modify fax callback phone number
DTMF * Replay Fax-On-Demand menu prompt message
DTMF # Done selecting faxes, exit Fax-On-Demand menu
Time Out Replay Fax-On-Demand menu prompt message
Fax Tone Receive fax to ‘current’ mailbox
Data Tone Negotiate data call and receive data files to ‘current’ mailbox

Explanations:
· DTMF 1 - Prompt for document number from current list and then add specified document to queue.
· DTMF 2 - Prompt for document number from current list and then remove specified document from 

queue.
· DTMF 3 - Add all the documents available in the current list to the queue.      Documents which are 

password protected will not be added.
· DTMF 4 - Prompt for document number from current list and then play descriptive voice message 

which is associated with document.
· DTMF 5 - Play descriptive voice message for each document in current list.
· DTMF 6 - Add the document which is an index of documents in current list to the queue.
· DTMF 7 - Prompt caller for number of desired document list and then switch to that list.      
· DTMF 8 - Play a descriptive message which describes all of the available document lists.
· DTMF 9 - Add the document which is an index of all available document lists to the queue.
· DTMF 0 - Enter or modify the callback number.      If the caller chooses callback, the system will 

prompt for the number at that time.      This option gives him the chance to change the number.
· DMTF * - Replay Fax-On-Demand menu prompt message.
· DTMF # - Done selecting documents.
· Time Out - Replay Fax-On-Demand menu prompt message.

Menu : Fax-On-Demand Item Descriptive Message Access
The Fax-On-Demand Item Descriptive Message Access menu.      The caller is listening to descriptive 
messages of the documents in the current list.

Prompt File
Event Action

DTMF 1 Restart current item’s description
DTMF 2 Play next item’s description
DTMF 3 Play previous item’s description
DTMF 4 Remove this item if it is in queue
DTMF 5 Add this item if it is not already in queue
DTMF 6
DTMF 7 Decrease volume
DTMF 8 Normal volume
DTMF 9 Increase volume
DTMF 0
DTMF * Replay menu prompt message
DTMF # Exit menu
Time Out Replay menu prompt message
Fax Tone Receive fax to this mailbox
Data Tone Negotiate data call and receive data files to this mailbox

Menu : Fax-On-Demand List Descriptive Message Access
The Fax-On-Demand List Descriptive Message Access menu.      The caller is listening to descriptive 
messages of the lists which are available.

Prompt File
Event Action



DTMF 1 Restart current item’s description
DTMF 2 Play next item’s description
DTMF 3 Play previous item’s description
DTMF 4 Remove all items from this list that are in queue
DTMF 5 Add all items from this list to the queue
DTMF 6 Select this list as the current list
DTMF 7 Decrease volume
DTMF 8 Normal volume
DTMF 9 Increase volume
DTMF 0
DTMF * Replay Mailbox Voice Message Access menu prompt message
DTMF # Exit Mailbox Voice Message Access menu
Time Out Replay Mailbox Voice Message Access menu prompt message
Fax Tone Receive fax to this mailbox
Data Tone Negotiate data call and receive data files to this mailbox

Menu : Fax-On-Demand Queued Item Descriptive Message Access
The Fax-On-Demand Queued Item Descriptive Message Access menu.      The caller is listening to 
descriptive messages of the documents which are already queued.

Prompt File
Event Action

DTMF 1 Restart current queued item’s description
DTMF 2 Play next queued item’s description
DTMF 3 Play previous queued item’s description
DTMF 4 Remove current item from the queue
DTMF 5
DTMF 6
DTMF 7 Decrease volume
DTMF 8 Normal volume
DTMF 9 Increase volume
DTMF 0
DTMF * Replay Mailbox Voice Message Access menu prompt message
DTMF # Exit Mailbox Voice Message Access menu
Time Out Replay Mailbox Voice Message Access menu prompt message
Fax Tone Receive fax to this mailbox
Data Tone Negotiate data call and receive data files to this mailbox

Menu : Mailbox
The Mailbox menu is accessed after the mailbox greeting has been played.      If the mailbox greeting has 
been disabled, then the Mailbox menu prompt will be played immediately.

Prompt File
Event Action

DTMF 1 Leave a message in this mailbox
DTMF 2 Play mailbox greeting
DTMF 3 Play mailbox information message
DTMF 4 Access Private Fax-On-Demand menu for this mailbox.
DTMF 5 Leave a fax in this mailbox
DTMF 6 Access Mailbox Remote Access menu for this mailbox
DTMF 7 Access Private Message Retrieval menu for this mailbox
DTMF 8 Access Private Voice-On-Demand menu for this mailbox
DTMF 9
DTMF 0 Local operator attention
DTMF * Replay Mailbox menu prompt message
DTMF # Exit Mailbox menu



Time Out Replay Mailbox menu prompt message
Fax Tone Receive a fax to this mailbox
Data Tone Negotiate data call and receive data files to this mailbox

Explanations:
· DTMF 1 - Record a message and leave it for the owner of this mailbox.
· DTMF 2 - Play mailbox greeting message if enabled.
· DTMF 3 - Play mailbox information message if enabled.
· DTMF 4 - Access Private Fax-On-Demand menu for this mailbox.
· DTMF 5 - The caller wants to target this mailbox for subsequent fax reception.      The system will exit 

the voice tree and enter fax receive mode.      The system will disconnect after the fax has been 
received.

· DTMF 6 - Enter the Mailbox Remote Access menu if enabled.      A password might be required.
· DTMF 7 - Access Private Message Retrieval menu for current mailbox.      This is where the caller will 

access the message which identifies the current location of the mailbox owner, among the other 
private messages which can be added to the list.

· DTMF 8 - Access Private Voice-On-Demand menu for current mailbox.
· DTMF 9 - 
· DTMF 0 - Get operator attention for this mailbox if enabled.
· DMTF * - Replay Mailbox menu prompt message.
· DTMF # -Exit Mailbox menu.
· Time Out - Replay Mailbox menu prompt message.

Menu : Mailbox Remote Access
The Mailbox Remote Access menu is used to listen to personal messages and retrieve faxes.      Also, the 
caller can access menus to remotely configure the mailbox.      Get item counts allows the caller to hear a 
message which counts up the number of voice, fax, data, and mail items in the mailbox.

Prompt File
Event Action

DTMF 1 Play new voice messages
DTMF 2 Play all voice messages
DTMF 3 Play new voice messages sorted by priority
DTMF 4 Retrieve new fax documents
DTMF 5 Retrieve all fax documents
DTMF 6 Retrieve specified fax documents
DTMF 7
DTMF 8
DTMF 9
DTMF 0 Access Mailbox Remote Configuration menu
DTMF * Replay Mailbox Remote Access menu prompt message
DTMF # Exit Mailbox Remote Access menu
Time Out Replay Mailbox Remote Access menu prompt message
Fax Tone Receive fax to this mailbox
Data Tone Negotiate data call and receive data files to this mailbox

Explanations:
· DTMF 1 - Play new voice messages.
· DTMF 2 - Play all voice messages that are not archived.
· DTMF 3 - Play new voice messages sorted by priority.
· DTMF 4 - Retrieve new fax documents.      Fax Retrieval menu will be invoked.
· DTMF 5 - Retrieve all fax documents.      Fax Retrieval menu will be invoked.
· DTMF 6 - Retrieve specified    fax documents.      Fax Document Select menu will be invoked and then 

Fax Retrieval menu will be invoked.
· DTMF 7 - 
· DTMF 8 - 



· DTMF 9 - 
· DTMF 0 - Access Mailbox Remote Configuration menu.
· DMTF * - Replay Mailbox Remote Access menu prompt message.
· DTMF # - Exit Mailbox Remote Access menu.
· Time Out - Replay Mailbox Remote Access menu prompt message.

Menu : Mailbox Voice Message Access
The Mailbox Voice Message Access menu.      The caller is accessing the personal messages in the 
mailbox.

Prompt File
Event Action

DTMF 1 Restart current voice message
DTMF 2 Play next voice message
DTMF 3 Play previous voice message
DTMF 4 Mark voice message as new
DTMF 5 Delete voice message
DTMF 6
DTMF 7 Decrease volume
DTMF 8 Normal volume
DTMF 9 Increase volume
DTMF 0 Access Mailbox Voice Message Options menu
DTMF * Replay Mailbox Voice Message Access menu prompt message
DTMF # Exit Mailbox Voice Message Access menu
Time Out Replay Mailbox Voice Message Access menu prompt message
Fax Tone Receive fax to this mailbox
Data Tone Negotiate data call and receive data files to this mailbox

Explanations:
· DTMF 1 - Play the current voice message again.
· DTMF 2 - Play next voice message in the list of available messages.
· DTMF 3 - Play the previous voice message in the list.
· DTMF 4 - Mark the current voice message as new.      Otherwise, the message is automatically 

marked as ‘old’.
· DTMF 5 - Delete voice message.
· DTMF 6 - 
· DTMF 7 - Decrease volume.
· DTMF 8 - Reset volume to normal level.
· DTMF 9 - Increase volume.
· DTMF 0 - Access Mailbox Voice Message Options menu so additional operations can be performed 

on the current message.
· DMTF * - Replay Mailbox Voice Message Access menu prompt message.
· DTMF # - Exit Mailbox Voice Message Access menu.
· Time Out - Replay Mailbox Voice Message Access menu prompt message.

Menu : Mailbox Remote Configuration
The Mailbox Remote Configuration menu.      Accessed from the Mailbox menu.

Prompt File
Event Action

DTMF 1 Record different greeting
DTMF 2 Record different information message
DTMF 3 Access Mailbox Remote Voice Configuration menu
DTMF 4
DTMF 5 Enable/Disable fax auto-forward to remote number
DTMF 6 Access Mailbox Remote Fax Configuration menu



DTMF 7
DTMF 8
DTMF 9
DTMF 0 Room monitor mode
DTMF * Replay Mailbox Remote Configuration menu prompt message
DTMF # Exit Mailbox Remote Configuration menu
Time Out Replay Mailbox Remote Configuration menu prompt message
Fax Tone Receive fax to this mailbox
Data Tone Negotiate data call and receive data files to this mailbox

Explanations:
· DTMF 1 - Record a different greeting.    The caller will be prompted whether to record over the primary

or the secondary greeting.
· DTMF 2 - Record a different information message.
· DTMF 3 - Access Mailbox Remote Voice Configuration menu.
· DTMF 4 - 
· DTMF 5 - Enable or Disable fax auto-forward to remote number.    The caller can toggle the state of 

the fax auto-forward.
· DTMF 6 - Access Mailbox Remote Fax Configuration menu
· DTMF 7 - 
· DTMF 8 - 
· DTMF 9 - 
· DTMF 0 - If the hardware supports the option, the room monitor mode will allow the caller to listen to 

the aural activity where the modem is located.
· DMTF * - Replay Mailbox Remote Configuration menu prompt message.
· DTMF # - Exit Mailbox Remote Configuration menu.
· Time Out - Replay Mailbox Remote Configuration menu prompt message.



Add Phonelist Entry - Telephony Tab
Use this tab to specify which phone number you would like to dial when using the phone list record to 
initiate and outbound telephony call.

You can select any of the available phone numbers or have the system prompt you for the number at the 
time of dialing, or specify a user-defined hard coded number.

The settings in this dialog are used to dial if you double-click a phone entry when in the TELECOMponent
window or if you drag and drop the phone entry onto any window in the TELECOMponent.



Add Phonelist Entry - Pager Tab
Use this tab to specify a pager record that can be used by the speed dial list or the message notification 
function of the VoiceMail tree.    You must specify the number of your service provider in the “Pager:” field 
of the Personal Tab.

First specify the type of pager that is going to be represented by this record.

For numeric pagers you can specify the time between dialing and actually starting to send out the page.    
A prefix and suffix field are also provided to allow for sending pages to services that also include voice 
mail.    For example, if the paging service message requests a 1 to leave a message or 2 to leave a page, 
you would put the number 2 in the prefix field (perhaps followed by a comma or two to provide a delay).    
The software will then dial the service, wait for the timeout period, send the 2 to start the page, send the 
page itself, then send the suffix to terminate the page which is usually the “#” character.

For alpha numeric pages, be sure that your ID and password are accurate if your service requries them.    
Also, make sure that the COM port settings on the right hand side of the dialog match the settings 
required by your paging service.

Once you have your pager properly defined, anywhere components asks for a pager record it is asking 
you to select the phone record where you have defined the pager details.



Fax Header Gallery

The Fax Header Gallery is a collection of your favorite fax headers.

You can add fax headers you have created to the gallery and it will provide a list of them that allows you 
to easily access any fax header you need.



Coverpage Gallery / Fax Header Gallery

NOTE:
          The Cover Page Gallery and Fax Header Gallery use the same dialog box style, so this
          help document covers both of them.

A gallery is a collection of documents you use frequently presented as a list for easy access.

To use the gallery:

- Select the document you want to use from the list and click [OK] to get it.

- If you want to see what the selected document looks like before you get it, click
    the [PREVIEW >>] button.

- Add new documents to the list by clicking on [ADD...]

- Clear a document from the list by selecting it and clicking on [DELETE].




